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BURNING & DODGING

N. David ng

dynamic range of the world around you match that of your film. For

landscape photographers the issue most commonly encountered was that it
exceeded what could be captured. A “straight print” from a negative shot under
such circumstances exhibited a wide array of tonal issues. Shadows were
“blocked up,” meaning that the negative was so thin in those areas they simply
went darker than the paper could differentiate detail. Meanwhile highlights
were “blown out,” meaning the negative was so dense in those areas were whiter
than the paper’s emulsion could show detail. So an incredible array of
techniques sprang up to try to solve it.

I n the film days there was almost always a contrast problem. Rarely did the

The most famous (and often most successful) approach for global contrast was
The Zone System in which Ansel Adams codified the old rule of “Expose for the
Highlights and Develop for the Shadows.” Endless varieties and
“simplifications” arose as authors cashed in on the common problem and the
complexities of Adams’ solutions. But all too often even that was insufficient to
put detail in the shadows and highlights as well. So such approaches as water
bath development, compensating developers, etc. were employed.

And yet, despite all of those efforts, still the negatives often arrived ready to be
printed on the paper with some of the shadows and highlights either lacking
detail or not of the desired density. The printing stage was then the last chance
to rectify the situation and a number of techniques fell to hand including the
most common, burning and dodging. In the darkroom, dodging, i.e. light held
back during the primary exposure made dark areas lighter and burning, i.e.
adding exposure in addition to the primary exposure to light areas made them
darker. But control of shapes and small areas as well as smoothly blending these
altered tones with the base tones of the initial exposure remained a huge problem
for all but the more skilled printers.
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In the digital world we have the marvels of HDRI (and to a lesser extent the
“Shadows and Highlights” function in PhotoShop™) to replace The Zone System
and it has the wonderful characteristic that it works with color where the Zone
System, if used with much altered development to color film, could result in
unacceptable color shifts. But still, there are times when the file arrives at the
final post production editing stage and has need of some local contrast control,
that is, burning and dodging all over again.

In the digital world however we have so much more control of this step. Not
only can we zoom in and alter densities down to a single pixel if we wished, but
there are multiple techniques, each with its own unique “look” and outcome,
that we can employ so that the final image corresponds ever most closely to the
photographer’s vision.

The main digital approaches we will consider in this handout are:
@ The Burn and Dodge tools
@ Using an Overlay Layer
@ Simulating Contrast masks
@ Using Layer Masks

Each has its pros and cons. You should learn each so you can select the right
editing tool to achieve your own specific visual goals. Unless noted in the text,
these approaches work and are applied the same in all versions of PhotoShop.!

BURN & DODGE TOOLS

PhotoShop’s Burn and Dodge tools are a nearly perfect analog to the darkroom
techniques of the same name. The Burn tool allows you to use a brush of any
size from one pixel to 2500 pixels, and of any degree of soft or hard edges to
darken areas of the image and blend seamlessly with the surroundings. The
Dodge tool has the same capabilities except it is used to lighten specific areas.

Both can render their effect in any percentage of exposure from 1% to 100% for
the precise amount of effect you want. These modifications to the tools are in the

' CS4 however has moved some menu items around and worse, now only shows part of a drop down menu.
If you are just sure you are looking in the correct menu but do not see the function or selection you want,
go to the bottom of the drop down list and click to show all menu items. This makes me crazy since most
of the functions I use seem to reside in the “hidden” parts of the menus. Also my illustrations are from a
PC but the Mac is nearly identical in terms of use.
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tool settings bar just below the main menu bar and will change with each tool
you select. Here is what it looks like for the Dodge and Burn tools

| &' Adobe Photoshop
File Edit Image Layer Select Filter View Window Help

.- e (0 ] A |

Brush: . ~
9

Here the brush is a 9 pixel soft brush, the range is set to mid tones which is the
best general setting (avoid using the highlight range) and the exposure is set to
28%.

ik The Dodge and Burn tools themselves are found in the
¥R tool bar usually on the left of the screen as shown here.
L (In the same tool set is also the “Sponge” tool used to
g‘ i saturate or desaturate selected parts of the image.)?
4.9, | Additionally, when you are working with either, by
ALY @ otas e holding down the Alt/Option key you can toggle back
N, T. z::,:;::lod and forth between the two on the fly. It all sounds
% perfect and easy to use.

a q Well, these tool are easy to use. But they are not perfect.

They work fine on a grayscale image but just as in the
film world, on a color photo they have some limitations
especially when trying to dodge highlight areas.

[e]jfe

@
5
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The greatest weakness is, just as in the color printing
world, burning and dodging, other than in very small
amounts, sometimes effect a color change in the areas
being editing. And digitally burning a highlight can results in the world’s ugliest
grayish mildew-like tone being created.

Additionally it is a destructive process that is hard to recover from mistakes if
they are discovered many strokes after they were made. Burning back in over a
mistakenly dodged area, and vice versa, does not always accurately replicate
what was there in the first place even with the same exposure percentages
selected.

My bottom line in my own work is that although there are times when I still use
them, it is usually reserved for those infrequent times as the editing is almost
done when some very slight tweak to the tonality of an area seems called for.
And then it is rare the exposure change is over 10% to 20%.

? The illustrations here are from CS1. CS4 changed the default appearance of the tool bar into a single row
to save some more screen space for the image but the settings bar is virtually unchanged.
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So I would suggest learning to use them by playing with them and seeing the

results on your own images. They are nearly intuitive to use and therefore easy

to learn. But for our purposes here we are going to concentrate on the more
complex but also much more satisfactory solutions to editing selected areas of
the image.

USING AN OVERLAY LAYER

This is the darkening and lightening technique most often taught or discussed in
texts and workshops. It is popular because it works and has far less unintended
color shifting as a result. Although it does take a few more preparatory steps
that the simple burn and dodge tools, once ready to go it is very simple to use.
Here are the steps to follow:

Step Action Result/Note
0 | Make sure all of the global editing | For a predictable workflow that builds steps
has been done. one on another see the handouts on
workflow.
1 | Open a New Layer with This will open the following dialog box
Layer—->New Layer
- & J Layers ( Channels X Paths H\)_‘
New Layer —— p— bl
Name: | Burn and Dodge | OK ] Lock: [ & 4 & Fill: [>]
[Juse Previous Layer to Create Clipping Mask
Mode: m Opacity: %
[“IFill with Overlay-neutral color (S0% gray)
?. 0 O ® & 3]
2 For the handout I renamed this to This will create a gray Iayer on ’[Op of your

“Burn and Dodge.” Set the Mode
to Overlay and check the box that
says “Fill with Overlay-neutral

color (50% gray). Then click OK.

original background layer. Make sure in the
layer’s Pallet, the mode also changed to
“‘overlay” and if it did not, change it now.

When the layer mode is set to overlay then
you will see the image as if nothing has
happened.
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3 | The process should have
automatically set the brush colors to
black and white. If it did not, then
do so now manually.

4 Select the brush tool and set opacity | would suggest you start with a low setting
(10-20%) and build the effect slowly with

repeated applications. This allows you to
blend areas much more smoothly.

and edge to the desired settings.

5 Anywhere you paint with black, the Note: if the little grey icon representing the
layer on your layers pallet is big enough on
your screen, you can see where you have

painted in the black and white colors.

image will get darker and without
changing color. Anywhere you
paint with white, the image will get
lighter without changing color

6 | When finished, flatten the image
with Layer—>Flatten Image.

This is the simplest, cleanest way to edit a la burning and dodging without being
destructive. Until you flatten the image the background layer has not been
touched. And you can always erase through or use a layer mask to return an
area to the original state.

SIMULATING CONTRAST MASKS

In the film world if Zone System, contrast burning and split toning still were
insufficient to handle tonal ranges, and if you had shot in large format, you could
then make and use contrast mask techniques for further control of highlight and
shadows in the printing stage. As noted above, if you shot color, messing with
the development also messed with color balance and there was no variable
contrast color paper. Exposure changes also had an effect on color so you
learned to adjust filtration along with exposure which made selected burning
and dodging while maintaining accurate color tricky and sometimes not
possible. So contrast masking was about your only option.

The contrast mask itself was made with litho film exposed to give the proper (it
varied with the needs of the primary negative) exposure for critical tonal areas
and then development was varied to control the densities in those exposed areas.
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This mask was sandwiched in registration with the main negative but often,
between the original negative and the contrast mask, was a sheet of slightly
diffused acetate or Mylar. From that process we derive the term “Unsharp
Masking” because a by-product of the process of smoothing out tones was that
the contrast on the edges of tones was enhanced creating the illusion of greater
sharpness. You can really see this effect in Dye Transfer and tri-color carbro
prints where it was standard practice’.

With digital photography that practice has pretty much disappeared. Photoshop
allows similar control; especially with the “Shadows and Highlights” function or
using layering techniques that it had pretty much been a bit of lost lore. The nail
in the coffin was the rise and common use of HDRI approaches to contrast and
tonal control.

But HDRI as well as the Shadows and Highlights function has a different look
than the old film-based unsharp contrast masking. So I was pleased to watch my
friend, Stephen Burns, demonstrate a simulation of the old process in Photoshop
using L*A*B color. Now here is another optional tool in your tool kit for tonal
control, with another possible “look” as a result. Below is the original image we
will work on.

NOTE:
Unfortunately
this technique can
only be done in a
later version of
PhotoShop from
CS2 and later.

Only you can
decide which
approach better
renders your
vision for a given
scene, but if you
were not
altogether pleased
with the look of
the Shadows and

? Take a close look at the Dye Transfer prints of Eliot Porter to see this effect clearly. Had he been making
digital prints we might even pronounced them to be “oversharpened” but as a darkroom technique it simply
created a different, if edgy, look to the prints.
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Highlights function and you had not shot an HDRI sequence but DID shoot in
raw and with a nearly perfect exposure, here, with a tweak or two from me, is a

very workable option for you, following Stephen’s* technique.

NOTE: This is one of those processes in which the sequence of the steps is

critical for success!

Result/Note

Step Action

0 | Make sure all of the global editing
has been done.

For a predictable workflow that builds steps
one on another see the handouts on
workflow.

1 | Create a Duplicate File. You can do
this in one of two ways:

@ Using the main drop-down
menu (Layer—>Duplicate
Layer...) or

@ Dragging the background layer
to the new layer icon at the
bottom of the layers pallet.

First we will deal with the highlight portions
of the image by creating a special layer
mode and mask.

To keep track you might rename this layer
“Highlight adjust”

— oJtd

] Layers \Channels ipaths L >

Normal

Lock: [ &+ @

ll Opacity: | 10096 g
Fill: | 1005 > |

Layer Mode and Opacity Settings

o Ol [

Back...

Layer Mask
Thumbnail

&

e

0 @, 5

t

New Layer Icon

Layer Mask Icon

* Do check out Stephen Burns’latest book on Photoshop tips and trickery.
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2 Turn the duplicate layer into a Note: In CS4 with its irritating truncated
Layer Mask by either: menu lists, you will have to go to the bottom
of the layer menu and select Show all
@ Clicking on the Layer Mask Icon | menu items in order to access the Layer
at the bottom of the layer’s Mask selection.
pallet, or
@ Selecting Layer—>Layer
Mask—>Reveal All from the
main menu bar.
3 | Change the Color Space from RGB | A window will ask if you want to flatten the
to L*A*B space with Image->Mode image, tell it to NOT flatten it.
then check Lab

4 | Open the Channels Pallet This is usually a tab in the same pallet
window as the Layers.

5. | Click on the Luminosity Channel This selects the grayscale channel in the
L*A*B color space.

6 | Return to the Layers Pallet

7 | Check on the Layer Mask You should see the double “frame” lines

Thumbnail to make sure it is active | around the thumbnail.
8 Assign the Luminosity Layer to the You will now see a small thumbnail of the
Layer Mask by selecting grayscale channel in the layer mask window
of the layers pallet.
Image—>Apply Image
(In CS54 you will have to expand the
Image menu to see all menu items.)

9 | Set the Layer Mode to Multiply You can now see a color image but the
contrast will look off. However the highlights
are being brought down to a workable level.

10 | With the layer mask still active The degree of blur will have a major effect

diffuse the image by selecting
Filter->Blur—»Gaussian Blur

And set the intensity to (usually)
between 5 and 20.

on the spread of tones in the image. Adjust
first the degree of blur and then the opacity
of the layer until the highlights are looking as
you desire. Pay close attention to the
previewed image to see the effect of these
changes on the tonalities.
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Gaussian Blur

Preview

= 100%

Radius: | 5.0]

pixels

11 Duplicate the top Layer by either Now we will deal with the shadows by
creating another but opposite type of layer
@ Using the main drop-down mode and mask.
menu (Layer=>Duplicate You might rename this layer “Shadow
Layer...) or adjust’
@ Dragging the background layer
to the new layer icon at the
bottom of the layers pallet.
12 | Click on the Layer Mask Thumbnail
and invert the image using
Image—>Adjustments—>Invert.
13 | On this layer change the Layer For many images this will be enough. You

Mode to Screen.

can adjust the amount of blur and the
opacity of the layer to suit your needs.

Sometimes however, the shadows are still
weak and need a bit more of a hit. That is
the case with our example so we will repeat
the shadow mask layer steps.
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13 Unfortunately (and this will vary with the
Cont. colors of your image) the process has really
boosted the saturation of the colors in the
image. We will need to tone it down to
make it a bit more natural.
But working on the top layer of this stack will
do virtually nothing to the saturation.
14 | We need to have a layer that is like This creates a blank layer with nothing on it
a single flattened layer but in which | SO itis cqmpletely t_ranSp?rent and the
all of the other layers are still intact screen will look as if nothing has happened.
should we need them. So create a
NEW blank layer by clicking the
New Layer Icon.
15 This convoluted key punch performs an

Limber up your fingers and
together press these four keys:

CIEDm S

Shift

interesting function called “Stamp Visible.”
That process creates on this new layer an
image that is identical to us having flattened
the lower layers.

[ labeled this layer “Combined”

In the following illustration notice the
settings for the layers. We only needed
partial opacity to give us some dark but still
luminous shadows.

Version 1: July 2009

© N. David King




Burning & Dodging on Steroids

Page 11

LA B

{ “ix
LAYERS [ EHS

E]Opadm 1009 > |
] Lock: [ 7 4 @ Fill: | 100% [ |
® ] combined

ﬁ@ Highlights copy 2
ﬁ@ E}m Highlights copy
bl e i oo

ﬁ Background a

s fx 0 © O 1 3 =

]
g ! [Novmal

Cl

@

Cl

16 | This particular image really had the Every image will be different. Some will go
reds and some yellow over saturate throu.gh the process and Ioc?k fine or _
through the process. To get rid of possibly even improved a bit. Others, like

. the sample here, oversaturated two colors.
the garish color I then desaturated _ _ _ o
the reds and yellows using the Hue Because each image is potentially unique in
d Saturation function: this you will need to adjust the colors as
and oaturation function. applicable for each specific file.
Image—>Adjustments—>
Hue/Saturation

19 | Flatten the Image using
Layer—>Flatten Image

20 You are now done.

Return to the RGB Color Space by
accessing Image->Mode—>RGB

OPTIONAL STEP:

I wanted to darken the blue of the
sky a little so followed the
instructions in my handout on
“Simulating a Polarizing Filter”

If the file is OK at this point then prepare to
save or do any further operations you wish.

My final version is shown below.
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Casa del Prado
1650 ElPrado.

BLENDING with LAYER MASKS

This approach lets you do far more than simply lightening or darkening an area,
it also allows you to selectively add or change color. It combines two of the most
powerful of PhotoShop’s editing tools: layers and masks all at the same time.

Above we worked with both of those tools. We created new layers of various
types and also used the layer mask to allow us to selectively “see through” the
top layer to the bottom layer depending on the opacity of the “hole” we were
making. Now we will do this with a vengeance to give us incredible editing
power over selected areas of the image.

The example I chose was a dawn shot in the Alabama Hills. I'm OK with most of
the image but the foreground not only needs some attention to bring it to life, it
is also an ugly blue grey sine it was completely in shadows. I want to make it
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look like some of that pretty dawn light was spilling over on to it because that is
the way I recall “feeling” it when I was standing there. Here is the starting point

I want to brighten the rock faces that are facing the light and add some sparkle to
the foreground brush. Here are the steps to take...

Step Action Result/Note

0 | Make sure all of the global editing | For a predictable workflow that builds steps
has been done. one on another see the handouts on
workflow.
1 To make sure we are working on the

Make a Duplicate layer just as we
did in the previous example.
However in this case we will be
working on the bottom
(“Background”) layer.

background toggle the “Eye” icon OFF on
the top/copy layer and activate the bottom
layer by clicking on it. You should see

something similar to the illustration below.

“Eye” is turned OFF

Bottom Layer is
Highlighted

LAYERS [[CHANNELS|IPATHS
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2 | Paying attention ONLY to the areas
you want changed, make whatever
tonal and color modifications you
want.

For this example | lightened the mid tones
with curves and using photo filter and color
balance imparted a dawn coloration to the
rocks and shrubs. Of course this effected
the whole layer but I'll solve that in the next
step.

LAYERS

ock: ] 7 b @

o F
ﬁ Background copy

=
Background a

s fx 0 © 0 3 3

3 | Now I will return to the top layer by
clicking on its “Eye” icon and on the
layer name. Then I will turn it into
a layer mask by clicking on the
Layer Mask icon or by using the
menus with:
Layer—>LayerMask—>Reveal All

When you create the Layer Mask it should
turn the colors in the tool bar Black and
White. If it does not, then do so manually
now.

4 | Select the Brush Tool and set the
opacity to around 20% or lower. 1
also use a very soft brush setting so
that it is easier to blend areas
smoothly.

When you “paint” with the brush set to
Black you will erase the top layer to reveal
the bottom layer. When you paint with the
brush set to White you will paint back the
top layer to hide the bottom layer. The
opacity setting will determine the degree of
change.

5 | When you are finished you can
flatten the image and save it. Or
you can do the “Stamp Visible” we
did in the Contrast Masking section
and then repeat this procedure for
other modifications.

Below is the final version.
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The change is subtle as it should be. We don’t want it to look phony, just a bit
better than the camera captured.

CONCLUSIONS

There is nothing to prohibit you from using combinations of any or all of these
approaches in order to make your shot look exactly as your vision for it requires.
Taken separately or together they form a very powerful arsenal of tools for you
to start enhancing your images.

Remember, even if you are shooting HDR or other specialized images, whatever
comes out of the generator for those images should still be thought of as merely a
“negative,” an intermediate step in the process that has you now ready to get
serious about editing the file and making it the very best it can be. These steps
will be taking you beyond simply being a camera operator and into the realm of
the artist who MAKES photographs and does not just TAKE snapshots.
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